
How to use Microsoft Excel to analyze � 
Automated Dispensing System (ADS) data

Scan the QR code to  
watch the tutorial video
www.simplist-us.com/waste-analysis-tutorial

Identifying Intravenous Push �Waste 
Transactions in Your Institution

Learn to:

	� Download reports  
from your �automated 
dispensing system�

	� Use Microsoft Excel to 
identify waste practices 
and opportunities to  
optimize product selection�

	� Identify automated 
dispensing cabinets 
with the most waste 
�transactions

For Pharmacists
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Introduction

Benefits of optimizing product size, taking 
special note to match product availability that 
closely aligns with commonly ordered doses 
of controlled substances include:

Common dose

Excess drug waste

Less time wasted
Less pharmacy time devoted to 
reconciling discrepancies and waste,  
and less nursing time devoted to  
wasting process

Less diversion risk
Fewer waste events, which helps 
minimize the risk of diversion

Less product waste
Less turnover of controlled substance 
waste disposal systems

Illustration above is for demonstration purposes only and not representative of all vial and syringe sizes.
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Use the table below to determine which waste events you may 
eliminate by matching product size to your practice.

In the following example we analyze waste from Fentanyl 100 mcg per 2 mL injection. 

For hydromorphone and morphine you will want to analyze the products seen in this 
table and the corresponding waste amounts. If you don’t use all of these strengths, 
you can eliminate those from your analysis.

Opportunities to reduce waste transactions

Current Product Waste Amount Optimal Product Size

Fentanyl 100 mcg per 2 mL 50 mcg Fentanyl 50 mcg per 1 mL

Hydromorphone 0.5 mg per 0.5 mL 0.3 mg Hydromorphone 0.2 mg per 1 mL

Hydromorphone 1 mg per 1 mL 0.5 mg Hydromorphone 0.5 mg per 0.5 mL

Hydromorphone 1 mg per 1 mL 0.8 mg
Hydromorphone 0.2 mg per 1 mL

Hydromorphone 2 mg per 1 mL 1.8 mg

Hydromorphone 2 mg per 1 mL 1.5 mg Hydromorphone 0.5 mg per 0.5 mL

Hydromorphone 2 mg per 1 mL 1 mg Hydromorphone 1 mg per 1 mL

Morphine 4 mg per 1 mL 2 mg Morphine 2 mg per 1 mL

Please see full Important Safety Information, including Boxed Warning, on pages 12–14. Also available at www.simplist-us.com.

Exporting an automated dispensing system report 
To start, you will need to export a report from your automated dispensing system.  
To download the report, follow these instructions:

Pyxis 

Report needed: Waste Activities

Located in BD Knowledge Portal, under the Audit tab �

•	 Run for 90-180 days worth of data�
•	 Download as a CSV �
•	 Open CSV file in Excel, and save it as an  

Excel workbook�

The Excel workbook will enable you to create 
�multiple worksheets to summarize large �amounts 
of data

Omnicell 

Report needed: Transaction Details by Item

Located in Omnicenter, under the reports tab�

•	 Click the select button under Date Range �to choose 
the desired date range; �90–180 days of data is 
recommended�

•	 Change your report filter to waste �transactions only�
•	 Export as Excel document

These systems occasionally update their reports. If you are unable to find the report using these instructions, look for a report 
that includes all waste transactions and the amount of drug wasted.

WARNING: ADDICTION, ABUSE, AND MISUSE; LIFE-
THREATENING RESPIRATORY DEPRESSION; NEONATAL 
OPIOID WITHDRAWAL SYNDROME; and RISKS FROM 
CONCOMITANT USE WITH BENZODIAZEPINES OR OTHER 
CNS DEPRESSANTS

WARNING: RISK OF ADDICTION, ABUSE, AND MISUSE; 
LIFE- THREATENING RESPIRATORY DEPRESSION; 

CYTOCHROME P450 3A4 INTERACTION; and RISKS FROM 
CONCOMITANT USE WITH BENZODIAZEPINES OR OTHER 

CNS DEPRESSANTS

WARNING: ADDICTION, ABUSE, AND MISUSE; LIFE-
THREATENING RESPIRATORY DEPRESSION; NEONATAL 

OPIOID WITHDRAWAL SYNDROME; AND RISKS FROM 
CONCOMITANT USE WITH BENZODIAZEPINES OR OTHER 

CNS DEPRESSANTS

Dilaudid® (HYDROmorphone HCl) Injection, USP Fentanyl Citrate Injection, USP Morphine Sulfate Injection, USP
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Insert a Pivot Table 
Now that you have your raw data in an Excel workbook, you will insert a Pivot Table. 

Step 1

To do this, click on any cell within 
the data set and then navigate to 
the Insert tab. 

Under the Insert tab, select 
PivotTable to summarize the 
information in the worksheet.

Note: If you’re using an earlier version 
of Excel, PivotTables may be under 
Table or Data along the top navigation 
rather than Insert.

A Create PivotTable dialog box 
will appear. 

Table/Range is pre-populated 
showing that you have selected 
the entire data set. 

For where to place your 
PivotTable select New 
worksheet and click OK.
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Edit Your Pivot Table Fields
You will notice a PivotTable Fields pane where you can edit and customize your pivot 
table. In this pane, you select the appropriate data headers to manipulate the data by 
dragging and dropping any of your existing table fields into one of the four fields in 
the pane.

Step 2

First, select the MedDescription 
field name and drag it down into 
the Rows field.

Next, select the WasteAmount 
field name and drag it down into 
the Rows field.

Then, select the WasteAmount 
field name again and drag it 
down into the Values field. 

Please note, this example uses 
Pyxis data. The table shows the 
corresponding Omnicell fields needed.

Adding the WasteAmount in  
the Values field will calculate  
the frequency of different  
waste amounts.

Now, you can see the different 
waste amounts for each drug  
and how often they occur.
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Filter Drug Name & Waste Amount
In this example, we are looking for fentanyl 100 mcg per 2 mL products. 

Step 3

First, click the dropdown arrow 
for the Row Labels column. 

Then, search fentanyl. Deselect 
all products except fentanyl 100 
mcg per 2 mL.

The drug naming conventions 
may vary in your system, so 
search for either 50 mcgs per 
mL and then a 2 mL injection. 
The drug name may be listed as 
the total drug strength. In this 
case, it’s the fentanyl 100 mcg 
per 2 mL.

Once you have selected the 
appropriate drug, hit OK.

Now you can see a list of waste 
amounts sorted from smallest  
to largest. 

To sort the list in order of the 
waste amount happening most 
frequently, right-click the cell 
in the Count of WasteAmount 
column and select Sort followed 
by Sort Largest to Smallest. 

The waste amount that occurs 
most frequently is at the top; in 
most cases, it is 50 mcgs.

We are looking for a waste amount of 50 mcg, which would indicate that the dose 
was 50 mcg. Since there is a 50 mcg per 1 mL product on the market, using a 50 mcg 
product here theoretically could eliminate all of these waste transactions because the 
ordered dose matches the product being dispensed.
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Calculate Percentage of Waste Transactions 
One additional value that is beneficial to know is the percentage of all waste 
transactions 50 mcgs represents.

Step 4

To calculate the percentage 
represented by 50 mcgs, return 
to the Pivot Table Fields, select 
the WasteAmount from the 
Field Name list, and drag it to the 
Values field.

You now have a new column that 
duplicates what you already have.

Field Names

WasteAmount

Pyxis users Omnicell users

waste_qty
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Step 4 continued

To see what the waste events 
represent as a percentage, go to 
the new column added, right-click 
one of the value cells, and select 
Value Field Settings. In the 
dialog box, choose Show Values 
As, select % of Grand Total 
from the dropdown, and click OK.

The field has been updated to 
display the percentage of each 
waste transaction compared to 
the total amount. Within the given 
time frame, there were 3,544 
waste transactions in total.

Out of those, the 50 mcg waste 
transactions accounted for 
52.71% of all the transactions.

Waste transactions can be 
eliminated by using products 
that more closely align with 
clinical practice. 

In this example, using a 50 mcg 
per 1 mL syringe may eliminate 
52.71% of the waste generated by 
the 100 mcg product.
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Identify Waste at the Cabinet Level
To utilize this data to create an inventory implementation plan for your new products, you 
will want to determine where this waste is happening in your hospital.

Step 5

First, let’s select the entire pivot 
table and copy it.

To copy an entire PivotTable, 
select anywhere within the 
PivotTable and then go to the 
PivotTable Analyze tab.  
From the Select dropdown, 
choose Entire PivotTable. Once 
the Pivot Table is selected, use 
Ctrl  + C  to copy and Ctrl  + V  to 
paste anywhere on the sheet.

Note: To expand columns, double-click 
between each.

Next, you should filter the data 
in the copied table to focus only 
on transactions that involve 50 
mcgs and identify where they 
occurred within the hospital. 

To do this, select a cell in the 
WasteAmounts column and 
apply a filter. 

Then, deselect all options  
except the 50 mcgs to view  
the relevant data.

To identify where this waste 
is occurring, return to your 
PivotTable Fields. 

Select WasteStation and drag  
it into the Rows section. Field Names

WasteStation

Pyxis users Omnicell users

omni_stid
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Step 5 continued

You will now see the cabinet 
locations within the hospital 
where you use a 50 mcg dose.

Next, you need to sort the values 
to identify the areas with the 
most significant impact to help 
you operationalize a change in 
your hospital. 

To view waste events by areas of 
impact, right-click on the Count 
of Waste column, choose Sort, 
and then select the Largest to 
Smallest option.

By doing this, you will be able 
to see where transactions with 
50 mcgs of waste occur more 
frequently.

You can see that 1,868 is a 
portion of the Total Waste 
Transactions from that fentanyl 
100 mcg.

We then take those 1,868 Waste 
Transactions and break them 
down to the cabinet level to 
identify where the waste occurs.

You can use this information to 
help you decide what you want 
par levels to be for your new 
product.
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Step 5 continued

To extrapolate these waste transactions into an annualized estimate you can use the 
following calculation.

You can also determine nursing time associated with this waste with the following 
calculation.

This calculation only accounts for one nurse. To account for the waste witness you can 
double this time.

Waste Transactions Calculation

( Waste Transactions  ÷ Data Set Time Frame ) × 365 days per year = 

Annualized Waste Transaction Calculation

Fentanyl Example Reviewed

( 1,868 transactions  ÷ 183 days ) × 365 days per year = 

3,726 transactions per year

Nursing Time Calculation

( Annualized Waste Transaction Calculation  × 76.2 seconds*) ÷ 3,600 = 

Nursing Time Associated with Waste (Hours)

Fentanyl Example Reviewed

( 3,726 transactions  × 76.2 seconds) ÷ 3,600 = 

79 Hours**

* 76.2 seconds is based on Nursing staff time associated with the wasting process from the Hertig study: Hertig J, Jarrell K, Arora P, et al. A Continuous 
Observation Workflow�Time Study to Assess Intravenous Push Waste. Hospital Pharmacy. Hosp Pharm. 2021;56(5):584-591

**To account for waste witness you can double this time.�
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Important Safety Information

Dilaudid® (HYDROmorphone HCl) Injection, USP

INDICATIONS AND USAGE
DILAUDID® INJECTION (hydromorphone 
hydrochloride), for intravenous, intramuscular, or 
subcutaneous use, is an opioid agonist indicated 
for the management of pain severe enough to 
require an opioid analgesic and for which alternate 
treatments are inadequate.

Limitations of Use: Because of the risks of 
addiction, abuse, and misuse with opioids, even 
at recommended doses, reserve DILAUDID 
INJECTION for use in patients for whom alternative 
treatment options [e.g., non-opioid analgesics or 
opioid combination products]: 

•	Have not been tolerated, are not expected to 
be tolerated

•	Have not provided adequate analgesia, or are 
not expected to provide adequate analgesia

DILAUDID INJECTION is contraindicated in 
patients with:

•	Significant respiratory depression.
•	Acute or severe bronchial asthma in an 

unmonitored setting or in absence of 
resuscitative equipment.

•	Known or suspected gastrointestinal 
obstruction, including paralytic ileus.

•	Known hypersensitivity to hydromorphone, 
hydromorphone salts, sulfite-containing 
medications, or any other components of  
the product.

Use the lowest effective dosage for the shortest 
duration consistent with individual patient treatment 
goals. Individualize dosing based on the severity of 
pain, patient response, prior analgesic experience, 
and risk factors for addiction, abuse, and misuse.

Warnings and Precautions: 
Life-Threatening Respiratory Depression in 
Patients with Chronic Pulmonary Disease or in 
Elderly, Cachectic, or Debilitated Patients: Monitor 
closely, particularly during initiation and titration.

Adrenal Insufficiency: If diagnosed, treat with 
physiologic replacement of corticosteroids, and 
wean patient off of the opioid.

Severe Hypotension: Monitor during dosage 
initiation and titration. Avoid use of DILAUDID 
INJECTION in patients with circulatory shock.

Risks of Use in Patients with Increased 
Intracranial Pressure, Brain Tumors, Head 
Injury, or Impaired Consciousness: Monitor for 
sedation and respiratory depression. Avoid use 
of DILAUDID INJECTION in patients with impaired 
consciousness or coma.

DILAUDID INJECTION contains sodium 
metabisulfite. There is a risk of anaphylactic 
symptoms and life-threatening asthmatic episodes 
in susceptible people.

Adverse Reactions: Most common adverse 
reactions are lightheadedness, dizziness, sedation, 
nausea, vomiting, sweating, flushing, dysphoria, 
euphoria, dry mouth, and pruritus.

To report SUSPECTED ADVERSE REACTIONS, 
contact Fresenius Kabi USA, LLC at  
1-800-551-7176 or FDA at 1-800-FDA-1088  
or www.fda.gov/medwatch.

Serotonergic Drugs: Concomitant use may result 
in serotonin syndrome. Discontinue DILAUDID 
INJECTION if serotonin syndrome is suspected.

Monoamine Oxidase Inhibitors (MAOIs): Can 
potentiate the effects of hydromorphone. Avoid 
concomitant use in patients receiving MAOIs or 
within 14 days of stopping treatment with an MAOI.

Mixed Agonist/Antagonist and Partial Agonist 
Opioid Analgesics: Avoid use with DILAUDID 
INJECTION because they may reduce analgesic 
effect of DILAUDID INJECTION or precipitate 
withdrawal symptoms.

Pregnancy: May cause fetal harm.

Overdosage: Acute overdose with DILAUDID 
INJECTION can be manifested by respiratory 
depression, somnolence progressing to stupor or 
coma, skeletal muscle flaccidity, cold and clammy 
skin, constricted pupils, and, in some cases, 
pulmonary edema, bradycardia, hypotension, 
partial or complete airway obstruction, atypical 
snoring, and death. Marked mydriasis, rather 
than miosis, may be seen with hypoxia in 
overdose situations. 

This Important Safety Information does not 
include all the information needed to use 
DILAUDID INJECTION safely and effectively. 
Please see the full prescribing information, 
including BOXED WARNING, for DILAUDID 
INJECTION at www.simplist-us.com.

WARNING: ADDICTION, ABUSE, 
AND MISUSE; LIFE-THREATENING 
RESPIRATORY DEPRESSION; NEONATAL 
OPIOID WITHDRAWAL SYNDROME; and 
RISKS FROM CONCOMITANT USE WITH 
BENZODIAZEPINES OR OTHER CNS 
DEPRESSANTS

Addiction, Abuse, and Misuse
DILAUDID INJECTION exposes patients 
and other users to the risks of opioid 
addiction, abuse, and misuse, which 
can lead to overdose and death. Assess 
each patient’s risk prior to prescribing 
DILAUDID INJECTION and monitor all 
patients regularly for the development of 
these behaviors and conditions.  

Life-Threatening Respiratory Depression
Serious, life-threatening, or fatal 
respiratory depression may occur with 
use of DILAUDID INJECTION. Monitor for 
respiratory depression, especially during 
initiation of DILAUDID INJECTION or 
following a dose increase.

Neonatal Opioid Withdrawal Syndrome
Prolonged use of DILAUDID INJECTION 
during pregnancy can result in neonatal 
opioid withdrawal syndrome, which may 
be life-threatening if not recognized 
and treated, and requires management 
according to protocols developed by 
neonatology experts. If opioid use is 
required for a prolonged period in a 
pregnant woman, advise the patient of 
the risk of neonatal opioid withdrawal 
syndrome and ensure that appropriate 
treatment will be available.

Risks From Concomitant Use With 
Benzodiazepines Or Other CNS 
Depressants
Concomitant use of opioids with 
benzodiazepines or other central nervous 
system (CNS) depressants, including 
alcohol, may result in profound sedation, 
respiratory depression, coma, and death.

•	Reserve concomitant prescribing 
of DILAUDID Injection and 
benzodiazepines or other CNS 
depressants for use in patients for 
whom alternative treatment options 
are inadequate.

•	Limit dosages and durations to the 
minimum required.

•	Follow patients for signs and symptoms 
of respiratory depression and sedation. 

IMPORTANT SAFETY INFORMATION
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Fentanyl Citrate Injection, USP

INDICATIONS AND USAGE
Fentanyl Citrate Injection, for intravenous or 
intramuscular use, is indicated for:

•	Analgesic action of short duration during the 
anesthetic periods, premedication, induction 
and maintenance and in the immediate 
postoperative period (recovery room) as the 
need arises.

•	Use as an opioid analgesic supplement in 
general or regional anesthesia.

•	Administration with a neuroleptic as an 
anesthetic premedication, for the induction of 
anesthesia and as an adjunct in the maintenance 
of general and regional anesthesia.

•	Use as an anesthetic agent with oxygen in 
selected high risk patients, such as those 
undergoing open heart surgery or certain 
complicated neurological or orthopedic 
procedures.

Fentanyl Citrate Injection should be administered 
only by persons specifically trained in the use of 
intravenous anesthetics and management of the 
respiratory effects of potent opioids. Ensure that 
an opioid antagonist, resuscitative and intubation 
equipment, and oxygen are readily available.

IMPORTANT SAFETY INFORMATION

Fentanyl Citrate Injection is contraindicated in 
patients with a hypersensitivity to fentanyl.

Risks of Skeletal Muscle Rigidity and Skeletal 
Muscle Movement: Manage with neuromuscular 
blocking agent. See full prescribing information for 
more detail on managing these risks. 

Severe Cardiovascular Depression: Monitor during 
dosage initiation and titration.

Serotonin Syndrome: Potentially life-threatening 
condition could result from concomitant 
serotonergic drug administration.  Discontinue 
Fentanyl Citrate Injection if serotonin syndrome is 
suspected.

Adrenal Insufficiency: If diagnosed, treat with 
physiologic replacement of corticosteroids, and 
wean patient off of the opioid.

Risks of Use in Patients with Increased Intracranial 
Pressure, Brain Tumors, or Head Injury: Monitor 
for sedation and respiratory depression. 

The most common serious adverse reactions 
were respiratory depression, apnea, rigidity, and 
bradycardia.

To report SUSPECTED ADVERSE REACTIONS, 
contact Fresenius Kabi USA, LLC, at  
1-800-551-7176 option 5 or FDA at  
1-800-FDA-1088 or www.fda.gov/medwatch.

Concomitant Use of CNS Depressants: May 
decrease pulmonary arterial pressure and 
may cause hypotension.  See full prescribing 
information for management instructions.  For 
post-operative pain, start with the lowest effective 
dosage and monitor for potentiation of CNS 
depressant effects.

Mixed Agonist/Antagonist and Partial Agonist 
Opioid Analgesics: Avoid use with Fentanyl Citrate 
Injection because they may reduce the analgesic 
effect of Fentanyl Citrate Injection or precipitate 
withdrawal symptoms.

Pregnancy: May cause fetal harm.

Lactation: Infants exposed to Fentanyl Citrate 
Injection through breast milk should be monitored 
for excess sedation and respiratory depression.

Geriatric Patients: Titrate slowly and monitor for 
CNS and respiratory depression.

This Important Safety Information does not 
include all the information needed to use 
FENTANYL CITRATE INJECTION safely and 
effectively. Please see the full prescribing 
information, including BOXED WARNING, for 
FENTANYL CITRATE INJECTION at  
www.simplist-us.com.

WARNING: RISK OF ADDICTION, ABUSE, 
AND MISUSE; LIFE- THREATENING 

RESPIRATORY DEPRESSION; 
CYTOCHROME P450 3A4 INTERACTION; 

and RISKS FROM CONCOMITANT USE 
WITH BENZODIAZEPINES OR OTHER 

CNS DEPRESSANTS

See full prescribing information for 
complete boxed warning.

•	Fentanyl Citrate Injection exposes 
users to risks of addiction, abuse, and 
misuse, which can lead to overdose 
and death. Assess patient’s risk before 
prescribing and monitor regularly for 
these behaviors and conditions

•	Serious, life-threatening, or fatal 
respiratory depression may occur. 
Monitor closely, especially upon 
initiation or following a dose increase.

•	Concomitant use with CYP3A4 
inhibitors (or discontinuation of 
CYP3A4 inducers) can result in a fatal 
overdose of fentanyl.

•	Concomitant use of opioids with 
benzodiazepines or other central 
nervous system (CNS) depressants, 
including alcohol, may result in 
profound sedation, respiratory 
depression, coma, and death. Reserve 
concomitant prescribing for use 
in patients for whom alternative 
treatment options are inadequate; 
limit dosages and durations to the 
minimum required; and follow patients 
for signs and symptoms of respiratory 
depression and sedation.
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Morphine Sulfate Injection, USP

INDICATIONS AND USAGE
Morphine Sulfate Injection is an opioid agonist 
indicated for the management of pain severe 
enough to require an opioid analgesic and for 
which alternative treatments are inadequate.

Use the lowest effective dosage for the shortest 
duration consis¬tent with individual patient 
treatment goals. 

Individualize dosing based on the severity of pain, 
patient response, prior analgesic experience, and 
risk factors for addiction, abuse, and misuse.  Do 
not stop Morphine Sulfate Injection abruptly in a 
physically dependent patient.

Limitations of Use: Because of the risks of 
addiction, abuse, and misuse with opioids, even at 
recommended doses, reserve Morphine Sulfate 
Injection for use in patients for whom alternative 
treatment options [e.g., non-opioid analgesics or 
opioid combination products]: 

•	Have not been tolerated, or are not expected 
to be tolerated,

•	Have not provided adequate analgesia or are 
not expected to provide adequate analgesia.

Morphine Sulfate Injection is contraindicated in 
patients with:

•	Significant respiratory depression.
•	Acute or severe bronchial asthma in an 

unmonitored setting or in the absence of 
resuscitative equipment.

•	Concurrent use of monoamine oxidase 
inhibitors (MAOIs) or use of MAOIs within the 
last 14 days.

•	Known or suspected gastrointestinal 
obstruction, including paralytic ileus.

•	Hypersensitivity to morphine.

Warnings and Precautions
Cardiovascular Instability: High doses are 
excitatory. Have Naloxone Injection and 
resuscitative equipment immediately available.

Life-Threatening Respiratory Depression in 
Patients with Chronic Pulmonary Disease or in 
Elderly, Cachectic, or Debilitated Patients: Monitor 
closely, particularly during initiation and titration.

Adrenal Insufficiency: If diagnosed, treat with 
physiologic replacement of corticosteroids, and 
wean patient off of the opioid.

Severe Hypotension: Monitor during dosage 
initiation and titration. Avoid use of Morphine 
Sulfate Injection in patients with circulatory shock.

Risks of Use in Patients with Increased Intracranial 
Pressure, Brain Tumors, Head Injury, or Impaired 
Consciousness: Monitor for sedation and 
respiratory depression. Avoid use of Morphine 
Sulfate Injection in patients with impaired 
consciousness or coma.

Adverse Reactions
The most serious adverse reactions encountered 
are respiratory depression, apnea, circulatory 
depression, respiratory arrest, shock and cardiac 
arrest. Common frequently observed adverse 
reactions include: sedation, lightheadedness, 
dizziness, nausea, vomiting, constipation and 
diaphoresis.

To report SUSPECTED ADVERSE REACTIONS, 
contact Fresenius Kabi USA, LLC, at  
1-800-551-7176 or FDA at 1-800-FDA-1088  
or www.fda.gov/medwatch.

Drug Interactions
Serotonergic Drugs: Concomitant use may result in 
serotonin syndrome. Discontinue Morphine Sulfate 
Injection if serotonin syndrome is suspected.

Mixed Agonist/Antagonist and Partial Agonist 
Opioid Analgesics: Avoid use with Morphine Sulfate 
Injection because they may reduce analgesic 
effect of Morphine Sulfate Injection or precipitate 
withdrawal symptoms.

Pregnancy: May cause fetal harm.

Overdosage: Acute overdose with Morphine 
Sulfate Injection can be manifested by respiratory 
depression, somnolence progressing to stupor or 
coma, skeletal muscle flaccidity, cold and clammy 
skin, constricted pupils, and, in some cases, 
pulmonary edema, bradycardia, hypotension, 
partial or complete airway obstruction, snoring, 
and death. Marked mydriasis rather than miosis 
may be seen with hypoxia in overdose.

This Important Safety Information does not 
include all the information needed to use 
MORPHINE SULFATE INJECTION safely and 
effectively. Please see the full prescribing 
information, including BOXED WARNING,  
for MORPHINE SULFATE INJECTION at  
www.simplist-us.com.

WARNING: ADDICTION, ABUSE, 
AND MISUSE; LIFE-THREATENING 

RESPIRATORY DEPRESSION; NEONATAL 
OPIOID WITHDRAWAL SYNDROME; AND 
RISKS FROM CONCOMITANT USE WITH 

BENZODIAZEPINES OR OTHER CNS 
DEPRESSANTS

Addiction, Abuse, and Misuse
Morphine Sulfate Injection exposes 
patients and other users to the risks of 
opioid addiction, abuse, and misuse, which 
can lead to overdose and death. Assess 
each patient’s risk prior to prescribing 
Morphine Sulfate Injection, and monitor 
all patients regularly for the development 
of these behaviors and conditions. 

Life-Threatening Respiratory Depression
Serious, life-threatening, or fatal 
respiratory depression may occur with 
use of Morphine Sulfate Injection. Monitor 
for respiratory depression, especially 
during initiation of Morphine Sulfate 
Injection, or following a dose increase. 
Because of delay in maximum CNS effect 
with intravenously administered morphine 
(30 min), rapid IV administration may 
result in overdosing.

Neonatal Opioid Withdrawal Syndrome
Prolonged use of Morphine Sulfate 
Injection during pregnancy can result in 
neonatal opioid withdrawal syndrome, 
which may be life-threatening if not 
recognized and treated, and requires 
management according to protocols 
developed by neonatology experts. If 
opioid use is required for a prolonged 
period in a pregnant woman, advise the 
patient of the risk of neonatal opioid 
withdrawal syndrome and ensure that 
appropriate treatment will be available. 

Risks from Concomitant Use with 
Benzodiazepines or Other CNS 
Depressants
Concomitant use of opioids with 
benzodiazepines or other central nervous 
system (CNS) depressants, including 
alcohol, may result in profound sedation, 
respiratory depression, coma, and death.

•	Reserve concomitant prescribing 
of Morphine Sulfate Injection and 
benzodiazepines or other CNS 
depressants for use in patients for 
whom alternative treatment options 
are inadequate.

•	Limit dosages and durations to the 
minimum required.

•	Follow patients for signs and symptoms 
of respiratory depression and sedation. 

IMPORTANT SAFETY INFORMATION
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